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Printing in Photoshop

In this lesson, we’re going to talk about what’s needed to print from Photoshop. 
We’ll first cover some of the basic concepts and then we’ll get into the specifics of 
all the necessary settings we’ll need to work with. 

First of all know that I greatly prefer printing from Lightroom as I feel like the pro-
cess is much easier and more streamlined. Lightroom allows us to use templates 
to make the process fast and easy, while Photoshop doesn’t quite have the same 
features. I’d like to show you how to make Photoshop more like Lightroom when 
printing.

Step 1: Consider the print when shooting 

Different cameras have different aspect ratios, and therefore the final images can 
be different shapes. Some shoot 16:9, others shoot 4:3, other shoot 3:2 etc. Differ-
ent papers also have different aspect ratios. If your camera shoots with one aspect 
ratio and the paper is a different aspect ratio, then you will either need to crop the 
image to fit the paper or end up with white space somewhere around the image. 
Knowing this, I will leave room for cropping when I’m out shooting in the field. This 
will allow me to crop in later (if necessary) without losing any of the key subject 
matter. 
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Step 2: Optimize for printing via soft proofing 

The process of soft proofing will allow us to optimize the image for a specific 
printing condition. Note that there is a separate Masters Academy video on soft 
proofing, so we’re not going to get into too much detail about it here. 

• Soft proofing allows you to preview what your print will look like on screen.

• When soft proofing, you will need to determine the ideal rendering intent: Rel-
ative or Perceptual.

• Often times, the colors in our images are too vivid to be printed, so soft proof-
ing will help to compensate for color shifts during the printing process.

• We will evaluate the image to see how much shadow/highlight detail we can 
retain and then fine tune the results. 

• If we make any changes to the image while in soft proofing mode, it’s a good 
idea to use adjustment layers. Then, we will name these adjustments and put 
them into a layer group/folder so that we later know what printer/ink/paper 
combination the layers were designed to compensate for.

Step 3: Crop to ratio, dimensions & resolution 

In this step, we will crop the image to a specific aspect ratio so that it’s the same 
shape as the sheet of paper we’re going to print on. In Photoshop, we also need to 
think about the width and height in pixels as well as the resolution. 

Basic considerations: 

• The camera aspect ratio rarely matches the print ratio.

• Print to fill paper and/or print for standard frame sizes?

• Custom sizes require more expensive custom framing.

• Consider the desired matting.

• Add space in Photoshop using the Content-aware fill command in conjunction 
with cropping (sometimes).
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Resolution One of the choices available to you when using the Crop Tool is the 
resolution of your image. The resolution determines how big the pixels that make 
up the image will be when they’re printed. If they’re ever too big, your image will 
look pixelated. 

• Print Resolution = How large the pixels are when printed. 

• 240-360 = normal range (Once you get above 720, you can’t see a difference.)

• Canvas can handle lower resolutions due to surface texture.

• Resampling DOWN does no harm, but it will wipe away any sharpening applied. 

• Resampling UP prevents jaggies in low res originals, but makes the image look 
soft/blurry.

• Sharpen for print only while viewing at 50% and at the final resolution. 

Step 4: Replace Photoshop print settings with Plug-ins!

A plug-in is a type of program we can use that will add a certain kind of function-
ality to Photoshop. The two largest printer manufacturers offer a free plug-in for 
Photoshop for both Mac and Windows that will make the process of printing in 
Photoshop much more similar to the printing process in Lightroom. You can find 
these plug-ins by doing a simple web search for:

Canon Print Studio Pro, or Epson Print Layout

Step 5: Print now or save to jpeg file for offsite printing
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Step 6: Consider the print viewing conditions. 

Good light sources:

• LED: Look for a high color rendering index or CRI (100=perfect). The lower the 
number is, the more the colors will blend together. 

• Color Temperature: 2700K (warm white) is similar to Tungsten/Halogen, which 
is common in homes. D50 (professional imaging standard) is more blue.

• Here are a few brands of lighting that render color well:

• https://www.ottlite.com

• http://www.solux.net/

The printing process in Photoshop

When preparing to print an image in Photoshop, the first think I’ll ask myself is 
whether or not it has been sized for print and whether or not it has the correct as-
pect ratio to fill the sheet of paper or frame that I’m going to put it in. I can find out 
by going to the Image menu and choosing Image Size. The Image Size dialog will 
show the image width and height as well as the resolution. Note that you can choose 
what measurement scale 
you’d like to see by click-
ing the menu to the 
right side of the Width 
and Height fields. I set 
these to Inches when 
preparing for print. You 
can change the image 
width and height here, 
but know that this meth-
od doesn’t allow you to 
specify the crop of the 
image. 

The Image Size dialog will show us the width and height as 
well as the resolution of the image. 

• https://gtilite.com

• https://www.soraa.com



Printing in Photoshop © Ben Willmore, All rights reserved 6

In order to really control the aspect ratio along with the way the image is cropped, 
I’ll activate the Crop Tool. With the Crop Tool active, some settings will appear in 
the Options Bar above the main image window. I’ll click on the menu on the left 
side of the Options Bar and set it to W x H x Resolution. I want my print to be 13” 
x 19” so this is what I will type into the width and height fields. Note that when you 
type in the numbers, Photoshop will automatically use the measurement system 
you currently have your rulers set to. If you would like to deviate from this, simply 
add “in” for inches after typing in the number (or the letters for whichever mea-
surement system you’d like to use). In the next field over, I’ll type in my desired res-
olution setting (300). Now I can drag the image around within the crop rectangle 
and/or drag the corners of the crop rectangle to make it larger or smaller in order 
to create the ideal crop. To lock in the crop, I’ll press the Return/Enter key or click 
the little check box icon on the right side of the Options Bar. When we do this, it 
will scale the image up or down in order to create an image that is exactly the size 
and resolution we specified.  

With the Crop Tool active, we used the width, height and resolution fields (highlighted) to 
specify the size of the crop box and therefore the final result. 
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One setting to be aware of when using the Crop Tool is the “Delete Cropped Pix-
els” check box. If this is turned on, it will throw away the information that’s outside 
of the crop rectangle. That’s a good thing if you’re going to send the file off to an 
outside printing company because the file size will be smaller. If you turn this set-
ting off, it will retain the information outside of the image frame so that you can 
go back and re-crop it later. 

At this point, I may sharpen the image. Know that there are three times when I will 
apply sharpening to my images. The first is within Lightroom or Camera Raw and 
this is to compensate for softness introduced by my camera. The second is within 
Photoshop and that is to apply creative sharpening, which may be limited to cer-
tain areas of the image. The final instance where I’ll apply sharpening is right now, 
right before printing. This is because the printed result usually looks softer than 
what I see on screen. 

Printing via Photoshop’s print dialog

Now that we’re ready to print, we can go to the File menu and choose Print. This 
will let us specify all of the settings for printing the image. If we were to choose the 
Print One Copy option, it will bypass all of the settings and use all of the settings 
that were used the last time we printed. Let’s look at the settings available within 
the print dialog.

Printer: The first setting at the 
top of the Photoshop Print Set-
tings is where we choose the 
printer we want to use. If the 
desired printer is not available 
in the Printer menu, we’ll need 
to go in and add it via the com-
puter’s operating system. The first menu in the Photoshop Print Settings dialog 

is where we choose what printer we’re going to use.
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Print Settings: The Print Set-
tings button is next, and when 
we click that, we’ll get the dia-
log that most programs show 
us when printing to the cho-
sen printer. This is also where 
we can add or delete print-
ers from the list. We’ll set the 
Paper Size and then click the 
Save button to return to the 
Photoshop Print Settings dia-
log. We’ll need to use the Lay-
out setting to specify whether 
we are printing a horizontal or 
vertical image. 

Color Management: The next group of settings is for Color Management. This is 
where we inform Photoshop about how our printer reproduces color so that Pho-
toshop can compensate when it sends information to the printer. I usually set the 
Color Handling menu to “Photoshop Manages Colors” and the Printer Profile menu 
to match the particular printer/paper combo I’m using. 

If the image is 16-bit, there will be a “Send 16-bit Data” check box. The images that 
can benefit from this setting are those that contain large expanses of color with 
little to no detail (ex: a smooth sky). If your image contains mostly areas of detail, 
you won’t really notice any difference when turning this setting on. Note that this 
setting will cause the image to take longer to print.

You will need to choose the appropriate Rendering Intent, and this is something 
that was discussed during the lesson on Soft Proofing. If you have not already 
watched that lesson, I highly recommend doing so before doing a lot of printing. 

The Black Point Compensation check box will take the darkest part of your image 
and make sure that it is reproduced as the darkest shade that the printer can print. 
I generally keep this setting on.

Clicking on the Print Settings button will call up this  
dialog and this is where we specify the paper size. 
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You’ll also notice a menu that is likely set to “Normal Printing.” If you click on this, 
you’ll find a Hard Proofing option, and this for when you want to use the selected 
printer to simulate the look of a different printer. An example of when you’d want 
to do this is if you are sending an image to print in a newspaper and you want to 
make sure that it can look as good as possible. If you choose the Hard Proofing 
option, some related settings will appear below and we can use these to specify 
what we’re hard proofing for and what profile should be used. 

Position and Size:  These settings will let us determine how the image is fit to the 
sheet of paper. If we already cropped the image to the exact size of the paper, 
then setting the scale to 100% should be fine. If we told it to print borderless, we 
would want to turn on the “Scale to fit Media” check box. This will make the image 
slightly bigger because most printers need the tiniest amount of bleed in order to 
be able to truly print to the edges. 

Within the Position and Size settings, we can see the Print Resolution listed. We 
just want to make sure that this number is what we expect. If it’s too small, we 
might want to close the print dialog, go to the Image Size settings and scale the 
image up in size. 

The “Print Selected Area” check box can be useful if we want to test print a small 
area from a very large image. It will cause Photoshop to only print the area within 
an active selection. This can be useful if you plan to make a huge print and you 
want to test out a small area before committing to using all that paper and ink. I 
usually keep this setting turned off. 

Printing Marks: The various settings within this cate-
gory will overlay different kinds of guides on the print-
ed image. For example, the Corner Crop Marks setting 
will place little crop lines on the corners of the image 
so that it may be easier to cut the sheet down to size 
after printing. 

Corner Crop Marks are  
overlaid on this print.
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Functions: There are three settings to look at under the Functions category. The 
Background setting can be useful when the image doesn’t fill the entire sheet of 
paper and we want a different color (other than white) to surround the image. 
Clicking on the Background button will present us with the Color Picker so that we 
can choose what color we’d like to surround the image. 

The Border setting will add a line around the edge of the picture. This can be use-
ful when you have a black and white image and part of the area along the edge of 
the frame is solid white. Adding a border will differentiate where the image ends 
and the paper begins. 

The Bleed setting will make the image a little bigger than the sheet of paper so 
that it will print borderless without any gaps between the edge of the image and 
the edge of the paper. 

Postscript Options Disabled: The settings here are only for if we are printing for 
graphic arts and not photographs. 

Soft Proofing Preview Options: There are some additional settings that run along 
the bottom of the print dialog. The “Match Print Colors” check box will allow you 
to preview the print here in the print dialog, and this basically means that it will 
turn on soft proofing. Turning this on will change the preview slightly to match the 
color and contrast that it will have when printed. The “Gamut Warning” check box 
will place a gray overlay on top of the image preview in the areas where the colors 
are too vibrant to be reproduced. The “Show Paper White” check box will slightly 
change the preview to reflect the actual brightness of the chosen paper. Note that 
if you’ve already done soft 
proofing, you’ve already 
seen this view and you’ve 
already adjusted your im-
age to optimize it. 

After we’ve gone through all of the settings in the print dialog, we’ll click Done. 
When we click the Done button and then save the image, all of those settings will 
be saved along with the picture and when we open it again later, Photoshop will 
remember them. 

The soft proofing settings appear as check boxes below 
the print preview.
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Printing via a plug-in

We mentioned in the beginning of the lesson that both Canon and Epson have free 
plug-ins you can download and these plug-ins make the printing process much 
more streamlined and much more similar to the printing process in Lightroom. I 
prefer to use the plug-in method over using Photoshop’s print dialog. 

After downloading the plug-in, simply double-click on the file and tell it to install. 
Then, you’ll need to quit Photoshop and restart so that the plug-in will be available. 

In the video example, we’re going 
to use the Epson software, but 
know that the Canon software 
works in the same way. To print 
via the plug-in, we’ll go to the 
File menu and choose Automate 
> Epson Print Layout. A dialog 
will appear asking us whether we 
should “Transfer active image” or 
“Transfer all images.” The first op-
tion will focus only on the active 
image and the second will focus 
on all the images open in Photo-
shop. We’ll choose the first op-
tion and then click OK. 

The Epson Print Layout dialog will appear, with a preview and some settings on 
the right. The top setting is the Preset menu and this is what can make the print-
ing process so much easier. We can save a different preset (or template) for every 
paper size/type we commonly use so that we only have to work through the set-
tings once. After that, it’s a one-step process. Let’s look at how to work through 
the settings and create a print preset.

When we choose the Epson Print Plug-In, we’ll be 
asked if we want to print the active image only or all 
of the images open in Photoshop.
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Printer Settings: This is where we choose the printer we’re going to use and the 
Media Type, which is the type of paper we’re going to print on. We’ll also need to 
specify the paper size. The Paper Source menu will change the settings that you’d 
usually find within the computer’s operating system print dialog and it’s where 
we specify how the paper is going into the printer. With the Epson Print Layout 
software, we can choose from printing on a roll of paper, printing on thicker paper 
that will load from the front or we can choose Standard, which will load from the 
sheet feeder. 

There is also a Quality menu with options for Speed, Quality and Max Quality. The 
Speed setting will print faster but in a lower quality. The Max Quality setting will 
print at a higher quality but it will be much slower because it will print in both di-
rections instead of just one. 

Layout Settings: This section is where we 
can determine if there should be any space 
around the image. The sliders will allow us 
to specify how much space should appear 
around the four sides and the Centering 
menu will let us determine where the im-
age should be positioned on the sheet of 
paper. Turing on the Margin Color check 
box will allow us to choose a specific color 
(other than the white of the paper) to sur-
round the image. I will drag all of the mar-
gin sliders all the way to the left so that 
there is no white area around the image. 
Because we have the Borderless check 
box turned on, these sliders will display a 
negative number when moved all the way 
to the left and that’s because it’s going to 
leave a little room for bleed, just to ensure that there will be no white slivers of 
paper around the edges of the sheet. 

The Layout Settings within the Epson 
Print Plug-In
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Color Settings: The next section of settings is where we determine how the colors 
should be handled. We’ll set the Type menu to Use ICC Profile and then set the 
ICC Profile menu to Auto Select. By choosing Auto Select, the choices we make at 
the top of the dialog will automatically cause it to choose the correct profile. We’ll 
need to use the Rendering Intent menu to choose between Perceptual or Relative 
and this is something we determine during the soft proofing process (see the sep-
arate Masters Academy lesson on soft proofing). 

Finally, we’ll make sure that the Black Point Compensation check box is turned on 
so that the darkest part of the image is mapped to the darkest color that can be 
printed. 

Note that if you had chosen to print more than one image, you could use the ar-
row keys in the bottom right corner of the image window to preview them one at 
a time. 

In the Epson Print Plug-In, the print preview is on the left and the print settings are on the 
right. Above the print preview is an option for cropping the image.
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If we did not manually crop the image before opening the Epson Print Layout 
software, we could click the Crop Image button in the upper left corner of the im-
age window and crop handles will appear around the image so that we can crop 
it here. 

The Browse button in the upper right corner will show a filmstrip bar below the 
main image window so that if we are printing multiple images, we can easily switch 
between previewing each of them. 

Save Preset: Once we’ve worked through all of the settings, we’ll click on the Pre-
set menu (at the top of the interface) and choose Save Preset. We’ll be prompted 
to name the preset and I like to include the name of the printer, the name of the 
paper and the dimensions of the image. Once you’ve set up a preset for all of the 
printer/paper combinations you commonly use, it is very easy to print. All you 
need to do is open the plug-in software, choose the correct preset and then click 
the Print button. 

Add space to expand an image in Photoshop

Let’s say that you cropped an image too tightly in the camera and now, your de-
sired aspect ratio results in a crop that cuts off important detail. You can attempt 
to expand the image by adding space to the side that’s needed by using a few 
Photoshop techniques. 

After opening the image in Photoshop, activate the Crop Tool in the Toolbar on 
the left side of the interface. With the Crop Tool active, there is a Content-aware 
check box in the Options Bar above the main image window. Turn this on and 
then use the crop handles to crop and expand the frame to your desired size. Hit 
Return/Enter to lock in the crop. If you have the Content-aware check box turned 
on, Photoshop will attempt to fill in the empty area with what it thinks should be 
there, based on the surrounding content. Photoshop may do an amazing job at 
filling in the area, or you might need to go in with the retouching tools and fine-
tune the results. 
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In general, you should be able to expand your frame and add content to the image 
by using a combination of the Crop Tool (using the content-aware setting), The 
Content-aware fill command (to fill in a selection), the Healing Brush and the Spot 
Healing Brush.

Here, the Crop Tool is being used to expand the image. The Content-Aware setting (circled)
is turned on so that Photoshop automatically fills in the empty areas.


